PH
Guidelines for using SketchUp with WUFI® Passive

1. WUFI Passive
1.1 Introduction

Thank you for your interest in learning WUFI Passive. WUFI Passive software is a building energy
software offering profound contributions to passive building energy tools, broadening the scope of
modeling methods through the capability of implementing static and dynamic modeling procedures.
WUFI Passive is a result of a collaboration between Fraunhofer-Institute for Building Physics (IBP)
and the Passive House Institute US (PHIUS) to suit the North American market. This guidebook
should be used as a framework for building 3-D geometry, plug-in to WUFI Passive, and navigating
WUFI Passive Software.

1.2 Accepted Software

As indicated in the PHIUS+ Certification Guidebook V2.1 Section 6.1.1 Accepted Modeling
Software all projects to be considered for PHIUS+ 2018 Certification must be modeled in the
respective software’s:

WUFTI Passive: 3 2 0 1 or later*
WUFI Passive Free: 3 2 0 1 or later*

A free version of WUFI Passive is available for download. Additionally, instructions for download
may be found here.

For full modeling capabilities, including dynamic WUFI modeling, license for the full featured
software are required, and are available in one, three, and ten-year periods. Licensure includes
featured automatic updates through the duration of the license. Respective software packages may be
purchased from the web shop. A summary of features included in the paid versus free version is
outlined here.

Individuals completing the PHIUS CPHC Training receive an eight-week license of WUFI Passive as
part of the certification process.

1.3 Computer Display Settings

WUFI® Plus and WUFI® Passive Additional hard disk space needed for project
Recommended: files:

Operating System: Current Windows OS Plus: average project: 1-2 GB

CPU: 1.6 GHz or higher Passive: average project: 1-2 GB

RAM: 4 GB better more Take from:

Video Adapter: 128 MB and better, OpenGL https://wufi.de/en/software/product-overview/s
2.0 capable ystem-requirements/

Hard Disk: 300 MB free space


https://www.phius.org/PHIUS+2018/PHIUS+%20Certification%20Guidebook%20v2.1.pdf
https://wufi.de/en/software/wufi-passive/
https://www.phius.org/documents/Downloading%20WUFI%20Passive%20Free%20v3.2.pdf
https://wufi.de/en/webshop/
https://wufi.de/en/software/product-overview/
https://wufi.de/en/software/product-overview/system-requirements/
https://wufi.de/en/software/product-overview/system-requirements/

1.3.1 WUFI Passive Usability Settings

PHIUS recommends the setup shown in the screenshot below. To update the ‘Usability’ settings, go
to Options > Usability from the main toolbar in WUFI Passive. This will bring up options for the
settings noted below.

e Tool Tip: Checking each of these boxes brings up ‘hover-over’ hints which can be helpful for
modeling.

e Comments: This selection allows a side window to appear in WUFI Passive which allows for
users to type in notes or comments on specific tabs directly in the software.

e Data recovery: Automatically saves copies of the current WUFI Passive file being worked on.

e Show edit icons in table: Any input in WUFI Passive that has an associated built-in
calculation or additional table available to input data will automatically show a grey square
with a °...” inside of it.

ey WUFI® Passive V.3.2.0.1 C\Users\jpsor\[  [Octien= ol
i General Colors [ Transparency View Usabilly Export Passive
File  Input | Optons | Database Help fool
ool tip
S = General [ & General info
j e d t—) F & Value range
@ = : Colors 1 & Reference(s)
rojec
- ! View &1 Tool tip PHIUS + Certification
=-[EL Cas
R ibili Comments
-5 {| Usibility E
- O No comments
BA{  Expon : » |
T (® Integrat=d verically into data-input form on the right side
i Passive -
i - ) ) .
i O 3 1
=) 1 Inteqratad horizontally into data-input form at the battorn
=]
SketchUp plugin | (7} Flaating window, size location st by user
o - P

Data racovery
[ Save data for recovery
Every |5 + minutes

Maximal 4 L diles
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2. CREATING 3-D GEOMETRY

2.1 Design Software Set Up

WUFI Passive software requires imported 3-D geometry of the respective building, and currently
offers imports from SketchUp, through a direct SketchUp plugin, with allowance of defining zones
and properties of building components within the software to be directly transferred into WUFI
Passive. Currently the SketchUp plugin is the recommended import method.

Instructions to download the WUFI Passive Plugin in SketchUp are as follows:

1. Right click on the WUFI Passive Icon and select ‘Run as Administrator’ to open WUFI
Passive
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2. Open SketchUp
3. In WUFI Passive go to options > SketchUp Plugin, the respective window will appear.

B WUFI ® Passrve V.3.2.01
File iInput | Optiona 1 Database  Help
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Color
1 B
L Cas| o
L s Usibility
: | Export Sefinad
1 Passree
L Residential
Skeachlip plugin
| T vauaized componerts

@ Mot wsualzed components
e Theenal bridges
&5 Inernal LoadwOccupancy
£ Ventilaticn/Rooma
£ Atiached zones
£ Remamning slements
i Systema

Sketchilp plugen =
] Uise phugin intio Skeachilip
4 SketchUp B poltwans must be mstalled on this compuier 1o use this option. Mo info aboul SlechUp 1 £
eund under
bl v ghogichvp oo

Plugin filais) must be put ints Skeichlis's Plugne™ sublolder

Ta find the phagine dirsctony:

Start ShetchlUn. choose menu dem: WindowFuby Corsole
Skeachlip's Ruby Console deplays

Tyed (or copy and pastn) the followng kg and press ENTER

|$leic"w'nd wuppord llvi"“mm'}| fp— Copy this text
Trpe iod copy and pasee) the dreciony inio the ieribos bekow

Eketchllp’s "Phaging” subleider
CilsersphasdppDats Roameng SketchLUintkeachip 20 15 Skeichl i Fluging

FindiChack Sketchiin’s Plugine” sublolder Inatall plugin

& Group commponents whven importing from SketchUp
& Check cormistency of polygons during impornt

v | 5] [ om

4. Go to SketchUp and open Window > Ruby Console. Copy the text from the WUFI Passive
Screen (Sketchup.find_support_file("Plugins*)). Hit enter, and the file extension will
appear in the ruby console window. Copy the entirety of the text populated in the window.

File Edit View Camera Draw Tools

» g /0O~

Window Extensions Help

Default Tray >
Manage Trays...

New Tray... !
Model Info

Preferences

3D Warehouse

Extension Warehouse
Extension Manager

Ruby Console
Component Opticns
Component Attributes

T
BT Ruby Conscle 8| Ruby Consale

/ SketchUp

Copy this Text

Paste Text from WUFI

Sketchup.find supporc_file ("Plugins")

5. Go back to WUFI Passive and paste the extension from the Ruby console into the
“SketchUp ‘Plugins’ subfolder:” and click “install Plugin”

Sa. Note that there is a check-box to select ‘Group components when importing from
SketchUp’.
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SketchUp plugin X
[ Use plugin into SketchUp

SketchUp 8+ software must be installed on this computer to use this option. More info about SketchUp ¢«
found under:
hittp:/www.sketchup.com

Plugin file(s) must be put into SketchUp's "Plugins” subfolder.
To find the plugins directory:
Start SketchUp, choose menu item: Window/Ruby Console.

SketchUp's Ruby Console displays.
Type (or copy and paste) the following line and press ENTER.

Sketchup.find support file("*Plugins”)
Type (or copy and paste) the directory into the textbox below.

C:/Use or/AppData/Roaming/SketchUp/SketchUp 2020/SketchUp/Plugins]
[ Find/Check SketchUp's *Plugins” subfolder Install plugin

[Hlcroup when importing from SketchUp
[ Check consistency of polygons during import

6. You should see a window indicating the Plugin was installed correctly.

*WUFI Passive does support gbXML files corresponding to CAD-programs such as REVIT, but there are known
challenges with this method of import and it is not currently recommended.

2.2 Preparing the 3-D Model

2.2.1 Building

To prepare the SketchUp Model for WUFI Passive, the model should reflect only the building
geometry; the building components/elements should have no thickness, be modeled as a singular
plane to the exterior of the thermal envelope.

This should include extrusions such as the elevator pit, penthouses, etc. Within the model each
component should be its own clickable unit. If ‘groups’ are created in SketchUp, they may need to be
‘exploded’ before importing into WUFI depending on which version of the SketchUp plugin is
installed.
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It is best practice to begin in SketchUp by modeling the building mass, followed by components such
as windows and doors which can be drawn directly on each surface. For simplicity, windows and
doors should be drawn in the same plane as the wall. Details such as reveal depth can be assigned in

WUFI Passive.

Facameters
Depth of werdow reveal o]
Distancs o edge of glazing & reveal fin]

Diepth o warsdow reveal fin] 35
Destarce bom edge of glasing o reveal® fnl 28

v,

Distance from Edge of Glazing to Reveal

Tclge of Tramspanent Part

Depth of
Windaw

The windows are entered into the building energy model in their actual size and configuration (every
lite), as a single polygon to represent both glass and frame. (Do not use rough openings).

WINDOW AND EXTERIOR DOOR SCHEDULE

|

UNIT SIZE R.O. SIZE ROUGH TOTAL
D FRONT VIEW SILL Opﬁ’f‘(’;go” UNITU- | SHGC
WIDTH | HEIGHT |WIDTH| HEIGHT | HEIGHT FACTOR
z 3 P 32 Jqv= W1 Casamant 18
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If a commercial building with repetitive windows is being modeled this can be further simplified:

Draw the geometry of one window > group line segments > click the move tool and pressing the CTRL key > enter the
distance between windows > press enter to create the first copy > type the number of repetitions followed by an asterisk
5% (5 for five windows) to create an array of equally spaced groups.

e s e R

w‘ - —

2.2.2 Site Shading/Context

The geometry should include areas that create shading as a site-shading calculator is a new feature in
WUFI Passive version 3.2. This reduces the time and complexity to calculate the numerical inputs
that were once required to account for horizontal/landscape obstructions entries, overhang, and
related shading components. However, if these components have not been decided upon, numerical
values may still be used for feasibility.

Usually, shading elements such as balconies or overhangs are modeled in contact with wall
components in SketchUp. Once these geometries are imported into WUFI, these may generate
interference errors between wall components, causing failure to import. Therefore, it is better to
separate the ‘shading element’ by a few inches from the wall component plane in SketchUp.

[~

=N
=\

N AT s U el

It is recommended to create ‘two’ additional circular components in SketchUp that will allow the
project’s geometry to be centered in WUFI. These are ‘opening’ components with ‘outer air’ assigned
to the interior and the exterior surfaces. The idea is that the midpoint between these two components
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coincides with the ‘ground level’ of the project in SketchUp. When the geometry is imported into
WUFI, these components will not shade or otherwise affect the project, but PHIUS recommends
deleting them.

2.2.3 Non-linear geometry

WUFI divides curved elements (circular walls or windows) that were modeled in SketchUp as a
single component into multiple flat planes/segments. In the case of transparent components, there is
potential for the segments to be broken into components that are too small to appropriately reflect the
frame conditions. To solve this issue, curved window elements in SketchUp should be modeled as flat
components for at least the width of each individual frame.

J\‘\\
T~

2.2.4 Troubleshooting Import

=

It is not uncommon for there to be loose geometry, line segments, and object intersection within the
model. If this occurs WUFI Passive will notify you and the geometry may be fixed within WUFI
Passive or SketchUp. If fixes are made within SketchUp, the file must be re-imported in WUFI
Passive. If the fix is made in WUFI Passive, there is no way to connect the changes back to the
previously imported WPS file from SketchUp.

Building geometry from scratch in SketchUp has been the most tried and true method for importing
geometry into WUFI Passive. Importing a geometry from other softwares such as Rhino, Revit,
ArchiCAD or AutoCAD into SketchUp can be done, but special attention needs to be given to
cleaning these files up to avoid convergence errors.

2.3 Assign Properties

Upon completing the geometry, WUFI Passive properties may be assigned to the components of the
model within SketchUp. This is done by right clicking on the component and navigating to the
WUFIplus properties tab. To speed up this process you can hold the Shift key or Ctrl key and select
multiple components of the same type at once to assign respective WUFI properties.



A method of ensuring that all components have been assigned with WUFI Passive properties is after
assigning properties, to right click and ‘hide’ that component. This method will ensure that no
components are missed or unintentionally assigned incorrect properties.

For larger projects, PHIUS recommends assigning components with larger surface areas, such as
walls, roofs and floor slabs first and then ‘hiding’ them. You can then click and drag over all of the
windows remaining to select them all at once. This allows multiple windows to be selected
simultaneously, and WUFI properties assigned in bulk, rather than window by window.

Components with the same WUFTI properties assigned (and same orientation from horizontal) will be
grouped together when imported into WUFI Passive. When modeling in WUFI Passive, windows
typically need to be grouped by different types; fixed, operable, glazed doors etc... Rather than
‘ungrouping’ and then ‘grouping’ the correct windows together by manually clicking in WUFI
Passive, these groups can be assigned much more easily in SketchUp.

To make grouping in WUFI Passive easier, there is a workaround using ‘Zones’ in SketchUp.
Multiple zones can be created in the SketchUp file to create groups of components that will import
together. These zones will predetermine groups in WUFI Passive. The windows will import into
WUFI Passive in separate Zones (Zone 1, 2, 3 etc.). Once in WUFI Passive, you can revise the ‘Inner
side’ of each group of windows back to the appropriate conditioned zone (typically Zone 1) and
delete the remaining zones that will no longer have visualized components. The additional zones may
then be easily deleted in WUFI Passive. This is beneficial when buildings have multiple window
types. (fixed, operable, storefront, glazed doors, sliding glass doors etc..)
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WUFI Property assignments include component type, inner side option, outer side option, and
orientation options.

Transparent

Opaque

Not Relevant (will not import into WUFI)
Ground

Opening (not used for PHIUS Certification, only
WUFIplus)

Respective zone/zones created,

Inner Side Outer air

Ground

Respective zone/zones created,

Outer air

Ground

Adiabate (Space with same inner conditions)
Ok

Reverse by export.

Component Types

Outer Side

Orientation Options

Additional notes:

Component types: Transparent and opaque are the most commonly used. Not relevant is the default
setting and will result in the component not being imported into WUFI Passive. Opening is only used
for the WUFIplus (dynamic side) airflow model.

Inner Side and Outer Side: If you have conditioned areas divided into multiple zones, the respective
zones may be created as shown above and assigned in SketchUp. PHIUS recommends to only use one
conditioned zone for simplicity, when possible. If multiple zones are required due to differences in
usage or set points, a separate model should be created as set points and usage type are not editable
for individual zones. The Adiabate property (called Space with same inner conditions in
WUFI-Passive) should be assigned to components that have the same properties on both sides,
resulting in the absence of heat transfer through the respective component. Use this setting for the
outer-side of a component that is attached to a conditioned space that is not part of the certified
portion of the building. For example, a multifamily building that has a first floor commercial space
outside of the certified space would assign the boundary of the commercial space to Adiabate.
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When to use ‘Attached Zones’ vs ‘Space with same inner conditions’. For more information see
Section 2.4 Unique WUFI Component Properties

Applicable components | Inner Side | Outer Side | Used for
Cf)mponents. m contact ‘Attached | Unconditioned, but sheltered spaces such as
with unconditioned, Zone 1 , .
Zone attics, attached garages etc..
but sheltered spaces
Components in contact . . .
. . Mixed-use projects where multiple models

with other certified Zone 1 Zone 1 . g

are needed to model varying building usage.
spaces
Cf)mponents mn .C(?ntact Spac? with Conditioned spaces outside of the passive
with other conditioned, | Zone 1 same inner o1 1

. ..., | building enclosure.

but not certified spaces conditions

Orientation Options: When you click on a component in WUFI Passive, there is a red arrow that
appears to show which side is the ‘Outer’ side. The red arrow always starts from the ‘Inner’ side and
points to the ‘Outer’ side. If the red arrow is pointing outward, choose ok. If the arrow is not pointing
to the outer side of the component, it is cleaner and quicker to flip the orientation of that component
directly in SketchUp by selecting the component, right clicking and choosing ‘Reverse Faces’. This

will ensure the SketchUp model is correct for future use.

Common property assignments include,

Component Type | Property Inner Side Outer Side Orientation Setting
Windows Transparent | Zone 1 Outer Air

Walls / Roof Opaque Zone 1 Outer Air Red Arrow points outward
Slab / Floor Opaque Zone 1 Ground

Shading Elements | Opaque Outer Air Outer Air Does Not Matter

If you mislabel or misassign a component, or need to make changes, this is not an issue as properties
can be changed and assigned in WUFI Passive. It is recommended to also fix the SketchUp file at the
same time for future use.

Save the respective file as a .WPS extension to further import into WUFI Passive. To do this, go to
Sketchup toolbar, Extensions > WUFI Passive > Save Geometry.

Alternatively, ‘Export Geometry’ can be used which will import the geometry into any open WUFI
Passive file for spot-checking if all elements will import before saving the WPS file. (Warning: If you
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have other WUFI Passive project files open, it will import geometry into that project file). Once any
issues are resolved, save as a .WPS file.

Once the SketchUp file has been saved as a .WPS it is best practice to open the file within the WUFI
Passive software. Note that saving a .WPS file is not the same as saving the Sketchup File. They are
two separate files. Saving a SketchUp file is done by going to File>Save in Sketchup, while saving a
WPS file is done by going to Extensions>WUFI Passive>Save Geometry. You cannot open a WPS
file in SketchUp, you must open a SketchUp file if you want to revise your WPS file.

2.4 Unique WUFI Component Properties

Components assigned to ‘Space with same inner condition’ (SIC), will count the area of the
component towards the surface area of the project for the airtightness testing criteria, but the surface
area will not be included when calculating the envelope to floor area ratios used to determine the
space conditioning targets. This means, these components are subject to the same airtightness criteria,
but transmission losses are assumed to be negligible. SIC should be assigned to any component that is
in contact with a conditioned space outside of the passive building thermal envelope.

Spaces assigned to ‘Attached Zones’ will count the area of the components towards the surface area
for the airtightness testing criteria and for calculating the envelope to floor area ratio used to
determine the space conditioning targets. ‘Attached Zones’ should only be used for unconditioned (or
semi-conditioned) spaces that are sheltered from true exterior conditions. The default for PHIUS
certification is to use a slight reduction factor (0.95) which buffers the exterior climate by 5% for
components assigned to attached zones.

3. Navigating WUFI Passive

3.1 Opening WUFI Passive

Open a blank/new WUFI Passive file, dialogs and menus will appear as shown below.

Caption Bar Menu Bar Tool Bar

e ,/f
B o Sy LIS = - e
Tie i Ceders  Membhese Mol e e

FE e —— i —— T -

Project Tree

Dialog Box

Status & Results Box

© Passive House Institute US 2020
11



4.1 Importing Geometry

To open .WPS geometry in WUFI Passive go to the Project Tree and click on the Building tab and
then select the SketchUp import tab. The gbXML is available for use of REVIT files, but this import
option is not recommended or covered in this guide.

&
File Input Opfions Database Help
Q= @ @ Scope | Passive house verification ~ || English/IP/Outer dimensions/PHIUS+ 201
[EL Project
ZEL Cascs Available elements (double dlick to assign)
e Casel PH case: Passive house: Residential
éﬁ Localization/Climate: User defined Attached zones.
52 PH case: Passive house: Residential [y Zmsiis
=117 Zene 1
Visualized components
Notvisualized components Geometry
L Thermal bridges S
&} Intemal Loads/Occupancy fem  Bulding Wizard
£} Ventilation/Rooms
£h Atiached zones
4 Remaining elements
{a} Systems (X} Change orientation
% 3D Editor
‘ T SketchUp Import
ST

4.2 Verifying Geometry Import

Upon importing geometry into WUFI Passive it is not uncommon for there to be loose geometry, line
segments, and object intersection within the model. If this occurs WUFI Passive will notify you and
the geometry may be fixed within WUFI Passive utilizing vertices from within the visualization box,
instructions for this are in section 4.4 Editing Geometry in WUFI Passive. Geometry may also be
edited in SketchUp and re-uploaded into WUFI Passive. If some components in the geometry do not
import, it is best practice to check that each component was assigned a property in the SketchUp
model and did not default to the not relevant setting.

4.2.1 Individual Component Orientation

When the geometry is successfully imported into WUFI Passive, check the component orientation.
The red component arrow in SketchUp will become a green vector arrow in WUFI. Vector arrows
should be pointing in the “outer” direction, the vector starts at the inner side and points to the outer
side of the components. This is very important when WUFI Passive calculates criteria such as solar
gain for windows, and inner and outer orientation of wall components. If the direction of a vector
arrow needs to be changed, click the component > select change orientation > inner <-> outer. Be
careful when making this change, as grouped elements will not necessarily have the same vector
orientation. If grouped components have different vector orientations, you should first ungroup these
components before changing the vector orientation. (If changes are made in the WUFI Passive
geometry, it is recommended to make the same adjustment in the SketchUp model).

© Passive House Institute US 2020
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Additionally, you may change the settings for the inner walls to a more obvious color difference. This
visually allows you to indicate that WUFI is reading inner and outer wall components correctly. The
default setting paints the exterior side of walls a cream color and the interior side of walls white.

At first glance, the model below appears to have imported well.

Going under ‘Options’ and then ‘Color/Transparency’ will allow you to change the color settings of
typically assigned components.

File  Input I()pi[)n:RI Dalabase  Help

J L @ | Scope Passive house verification | English/IP/Outer dimensions/PHIUS* 2015 Assign dals | Project/Cases/Case 1: Karpiak Mulhall Pa|
[EL Project ~
L [EL Cases Available elements (double click to assign)
=-£5, Case 1: Karpiak Mulhall Passive House Options X
2} Localization/Climate: WILKES-BARRE SCRANTO| 1| Colors / Transparaney v e
& 9 Genera G i sability  Expol assive
-] PH case: Passive house: Residentia Standard colors User defined colors
! - fit Zone 1: Inside =
H £ Visualized companents Outer wall. inner surface 1 New
T~ Component 1: Roof Quter wall. external surface Delete
i w]D Component2: Exterior Walls =] Copy
% ent 3 Exterior Walls
. T Component 3: Ext mr\A Il —— & Insert
| i Componentd: Slab on Grade
Floor after >

Ceiling
Sloped roof. extzrnal surface
Sloped roof. inner suriace
Sloped roof, thaich

Flat roof, external surface:
Flat roof. inner surface
Surface contacting ground
Ground above

Ground bsneath

Transparency

Set standard values

ben Concel | ||
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As outlined above, we will change the ‘Inner surface’ color of our exterior walls to confirm all
components are oriented correctly. From the typical white, we’ve changed the color to magenta.

L New
Delete

Inner wall Copy
X || Insert

Window
Floor = >
Ceiling

Sloped roof, external surface

Sloped roof,

|
r surface
Sloped ate
Flat roof. external surface
Flat roof ce
Surface contacting ground ustom c

rrrrrrr -
rFrrrrrr -Hueﬁ\ Red: 255

o
2
H

g

Ground above

Ground beneath

Sat:[290]  Green:[0|
e ColoriSokd |, ﬂ] Blue: \E‘
oK Cancel Addto Custom Colors

Set standard values

With the new color assigned, it becomes clear very quickly that the wall outlined in red is not
oriented correctly and the newly assigned magenta inner side is facing outwards.

The most common components to be oriented incorrectly are windows. Windows are transparent and
are assigned the same color on both the interior and exterior side, so it can be tricky to confirm the
windows are oriented properly at first glance.

A visual inspection is the only reliable way to confirm if the windows are oriented correctly. The first
step in this visual inspection should involve assigning reveal depths to all windows. Before reveals
are assigned, the windows will appear flush with the exterior walls as shown below.

© Passive House Institute US 2020
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To assign reveals, select a single window and assign the correct reveal inputs under the Solar
Protection>General tab. Definitions for the two reveal entries are noted below.

e Depth of window reveal: Measured from the outside of the leading shading edge to the
glazing.

e Distance from edge of glazing to reveal: Measured from the edge of glazing to the shading
edge.

Reveal Shading (Plan view)

Distance from Edge of Glazing to Reveal
Shading Edge

Depth of Window Reveal

Edge of Glazing

After entering the reveals for a single window, you can assign reveals in bulk to all windows by
clicking the ‘Assign data’ button. This button allows you to choose which data you’d like to assign
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and check the boxes for which windows you’d like to assign that data to. Hold ‘Ctrl’ to select more
than one of the ‘Data’ entries on the right side of the screen. Selected entries will be highlighted in
blue. For this example, we’ve assigned the same reveal to all windows.

File Input Options Database  Help

J 7 @l %  Scope Passive house verification “ EnglishIPiOwer dimensions/ PHIUS + 2018 |ﬁsslqndam |

()4 Visualized components
= Component 1: Roaf
--[Z Component 2 Exterior Walls Genera

General  Window parameters  Selar proteciion

-z Companent 3 Slab on Grade

-~ Component 4 Casement 1- North FF
fl Component 5 Casement 4 2 - East FF D=l of window reveal [in] 5
B Component 6: Fixed 3 - East FF i

i Paramelers

oo e o South £F { Distance from edge of glazing o reveal fin] 3
“omponent 7- Sliding Door 5A 6B - South F H :
B Component 8: Fixed 7 - West FF ED'.her shading fraction of solar exposure (1=full exposure, O=total shading) [] 1
-l Component 8 Casement 8 - West FF {Other shading summer fracion of solar exposure (1=full exposure, D=bolal shadin 1

M Component 10 Fixed 8- harth EE i

8] X
I 3 jects to which data will be assigne; clecta ata al
M Component 13 Fi| Objects to which data will be assigned Selectall Dat Selectall
@ Component 14: Fif .10 Case 1: Karpiak Mulhall Passive House Depth of window reveal [in}:

fl Component 15: C:
fl Component 16: i

Hﬂé‘
[v]
i
&
™
=
)
i
[
L
=z
=
=
@
o
&
b
%
i
=L
g
2
i

Distance from edge of glazing to reveal [in]: 3

Height of landscape obstruction [f] 57

@ Component 17: Fi B Compenent4: Casement 1 - North FF Distance of landscape obstruction it} 100
fl_Comnanant 18 E;

m
s}
H-

i
g
o
=
[
g
]

-4IH Component 5 Casement 4 & 2 - East FT Other shading fraction of solar expasure (1=full expasure, O=total shading) [: 1

-#IE Component 6. Fixed 3 - East FF Other shading summer fraction of solar exposure {1=full exposure, O=tetal shading) [1: 1
~IAB Compenent 7: Sliding Door 54 & 5E - South FF
-1 Component 8 Fixed 7 - West FF

~#IE Compenent 9. Casement & - West FF

48 Companent 10 Fixed 8 - North FF

-iIB Component 12: Casement 14 & 12 - East SF
~[ Component 13: Fixed 13 - East SF

~IFB Component 14: Fixed - 17/16/15 - South SF
-1 Component 15: Casement 19 & 18 - Wesl 8F
&A@ Component 16: Fixed 22 & 21 - South FT
-0 Companent 17: Fixed 20 - North SF

~&8 Component 18: Entry Door 23 - North FF
-8 Component 19: Door to Screen Porch

-1 Component 20: Casement 6 - West FF

e DE&GE R E

Helo OK Cancel

B

After the reveals have been assigned, the 3D visualized geometry is updated to show the windows
pushed back from the facade. If you look closely, the window circled in red below does not have
quite the same reveal look as the rest of the windows in the building.

To confirm that this is indeed an incorrectly oriented window, right click in the black space of the
model and choose ‘Select all components’. This will activate the green vector arrows for all
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components and you see the window circled in red does not have an outward pointing green vector
arrow like the rest of the windows, walls and roof.

Select all components

Show all camponents

4.2.2 Building Orientation

Verify that the orientation of the building matches the orientation that is found in the architectural
drawings. You may check the orientation by expanding the visualization box and clicking the
orientation icon. Note that one of the facades will display ‘MF’ (main facade). This will be the facade
you are defining the orientation to. If the orientation needs to be changed, right click the icon and a
respective box will appear.

Change crientation X

JType definition
N
‘\'\!2 Wain orientations

O Azimuth

Orientation | South W

Azimuth [*] 18

4.3 Grouping Components

Grouping like-components should be a standard practice utilized in each individual energy model, for
both ease of use, speed and consistency. Grouping becomes significant when assigning component
assembly and surface details. For this reason, only components with the same properties and
inclination may be grouped.

To group components, click the component > hold the “CTRL” key > select any like-components >
right click > group.

Ungrouping components is also an option, to do this, right click on the component > Ungroup. Two
options are available here, “ungroup main component”, which ungroups only the component selected,
and “ungroup all selected components”, which ungroups everything.

As groups are created, they become available for viewing in the Project Tree, under Visualized Components.
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WUFI Passive begins to identify the components of respective groups as shown in the photo below.

ks WUFI®Passive V.3.2.0.1

File Input Options Database Help

) 7 d @ Scope Passive house verification

~ | English/IP/Quter dimensions/PHIUS+ 2018

Assign d

£

@é:w:d General Window parameters Solar protection
=8 ases
5.5 Case 1 Name
\-54 Localization/Climate: User defined
4} Building
S £ PH case: Passive house: Residential ;
i ﬁ Zone 1 Type/Attachment
=7 Visualized components Type Transparent
i = Component Inner side Zone 1
C t
- Outer side Quter air
™ Component
4 COmMponent Data
0 Component Area [f] 18.96/1162.78
Clvisuanized componen! :
# Thermal bridges Inclination [] 90
Internal Loads/Occupancy Orientation S(13%). E (13 %), W (70 %). N (4 %)
L J
N Ahge\;e:::;mﬂmms Window width [ 292
4= Remaining elements Window height [fi] 6.5
-} Systems Perimeter [f] 18.83
= Paramete
= Farameters
il Uw -mounted [Btu/hr fi? *F]
9- Frame factor [
& & | Datastatelresults @ || P Calculate WUFI shading
%4 Case 1/ Climate
(Tx Not valid data: Latitude.
a3

Naming conventions for each component should be identified and used for organization.

4.4 Editing Geometry in WUFI Passive

As noted in the sections above, editing geometry directly in WUFI Passive is not recommended
except for small changes. Any changes made in WUFI, should be duplicated in the SketchUp file

used for the original import. At this time, there is no way to export the geometry from WUFI Passive

back to SketchUp.
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The 3D Visualized Geometry window has multiple tools which are defined in the following figures.

W N
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3D Preview of Building - WUFI-Passive Tools

Expands the 3D visualized geometry window. | 5]

Building Wizard: Overrides existing geometry. | s

Zones: ‘Left click’ and hold will hide/view elements assigned to different zones. | &~

Axis Rotations: Rotate the 3D visualized geometry around the axis chosen. Example: ‘Left click’| &

the ‘Z’ axis button to rotate counter-clockwise. “Right click” the Z’ axis button to rotate clockwise. | ¢
If an axis rotation option is selected, a mouse scroll wheel will rotate the building. of

Center the Building: Re-centers the 3D visualized geometry window on the origin point. | [

‘Left click’ = zoom in. ‘Right click’ = zoom out. If selected, a mouse scroll wheel will zoom. | &
Toggles all components between opaque and transparent.| (J

Toggles the compass rose on and off. | ++s

Toggles the green vector arrows on and off. PHIUS recommends keeping these vectors turned on.

e

Toggles components that have ‘Enable not visible/not selectable’ on and off. See notes below.

Select a component with a ‘Left Click’. While component is highlighted, ‘Right Click’ to open ‘Kind of
Component’ properties. Check/Uncheck the box for ‘Enable not visible/not selectable’.

Select a component (wall or roof) with a ‘Left Click’. Click the ‘Comonent Openings’ icon and a
2-D view of the component selected will appear. Windows and openings can be edited in this view.

Toggles vertices on/off. Useful when making small adjustements to building geometry in WUFL.
When not making adjustements to vertices, PHIUS recommends toggling this option off.

Options dialogue box. Allows adjustments to be made to color/transparency of all component
types, vertice sizes and other options for view in the 3D visualized geometry window.
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To edit geometry in WUFI Passive, it is recommended to use the expand/shrink window tab to make
the geometry full screen. Once the geometry has been expanded to full screen, all options are visible
on the toolbar.

4.5 Creating a New Component in WUFI Passive using Vertices

Click the vertices visible/invisible tab, to activate the vertices.

I

Sk o| OB &N dk Py

To create a component in WUFI Passive, in this case a floor, select the vertices in a counter-clockwise
fashion, clicking each vertice while holding the CTRL key.

Bl

2 P Py

i

S EN):
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Once the vertices are selected right click to see additional options > Make component of selected
vertices

el |

2 | By
4

W &g

New Copy/Move vertices

(48]
Find intersecting points with vector

Make compeonent(s) on line

Delete selected vertices

= ool O

Kind of component

Type
® Opaque

(@] Transparent

(@] Opening
Attachment
Inner side | Zone 1

Quter side  Ground

Set default color

INner Quter wall, inner surface

Outer 5y face contacting ground

[ Enable notvisible/not selectable




Once Properties are assigned, the geometry is created.

M

B o eko OF &SR DYy

When two vertices are selected, the 2 points operation becomes available, which may be beneficial in
determining distances between vertices and creating additional lines or components. Copying and
moving components may be available when vertices are selected. Vertices may be created by right
clicking the expanded screen and selecting the new vertices tab, then inputting the X, y, z, coordinates
of the desired vertices.

4.6 Editing Windows in WUFI Passive

In general, if significant changes are needed, PHIUS recommends making changes in the SketchUp
model and re-importing the geometry. However, small revisions can be made within the software if
needed.

Windows may be added in WUFI Passive by first selecting the wall/roof component (in the 3D
visualization) that the window will be placed in, then clicking the Windows/Openings tab. The
Component openings dialog box and toolbar will appear.

O New

New/Copy Move

Delete

00 | Select All
Edit List

Change View from Inside/Outside
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To create a new window or opening select the New tab. The shape, position, and measurements may
further be input into the dialog box and the window will be created.

| | | | 12

Type
_ | |Rectangle o/ .
Data z
X' [f] 3.2808
Y [f] 20528
— 1 |width [f] 3.937 E
Height [ft] 49213 ¢

_\ = :

You can copy the newly created window by selecting it > right click> copy and move. You will be
prompted to enter the X and Y coordinates along with the number count. After a window is created,
you can also click and drag the window to the desired location in the dialog box. Windows that are
preexisting may also be copied or moved using the same procedures. Once you close the dialog box
the changes will be reflected on the building geometry.

4.7 Non-Visualized Components
Due to limitations with how non-visualized components interact with visualized components, PHIUS
does not recommend using non-visualized components.

Exceptions: A non-visualized component may be used to represent small amounts of opaque envelope
area such as an elevator pit or other extrusions that do not include windows.

4.8 Openings

A SketchUp import may automatically generate a component categorized as an ‘Opening’ when there
1s an extrusion from an opaque component, which creates a void at the plane of that opaque
component. Otherwise, ‘opening’ components should not be used for PHIUS+ Certification models.
This component type is reserved for air-flow modeling in WUFIplus.

For all other modeling related questions, refer to the most updated version of the
PHIUS+ Certification Guidebook. You may contact certification@phius.org with
further questions.
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